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Chapter 712

One-Sample Tests for
Exponential Hazard
Rate
Introduction
This module computes the sample size and power of the one-sample exponential hazard rate test which is used to
compare the hazard rate of a single treatment group to that of a historic control. This test is often adopted in
clinical phase-II trials with survival endpoints. Accrual time, follow-up time, and hazard rates are parameters that
can be set.
The procedure is documented in Jung (2013).

Technical Details
One-Sample Exponential Hazard Rate Test Statistic
The following details follow closely the results in Jung (2013).
Suppose N subjects are enrolled in a study during the accrual period of length ta and then observed during a
follow-up period of length tf. Let ti and Ci denote the failure time and censoring time of the ith subject. Let Xi be
the minimum of ti and Ci. The observed failure indicator is δi = I(ti ≤ Ci). The MLE of hazard rate is defined as the
ratio of the number of observed events E and the total observed survival time X, as follows.
𝜆𝜆̂ =

where
𝑁𝑁

𝐸𝐸
𝑋𝑋

𝐸𝐸 = � 𝛿𝛿𝑖𝑖
𝑖𝑖=1
𝑁𝑁

𝑋𝑋 = � 𝑋𝑋𝑖𝑖
𝑖𝑖=1

To test the statistical hypothesis 𝐻𝐻0 : 𝜆𝜆 = 𝜆𝜆0 versus 𝐻𝐻𝑎𝑎 : 𝜆𝜆 < 𝜆𝜆0 , we use fact that √𝐸𝐸�ln�𝜆𝜆̂� − ln(𝜆𝜆)� is
approximately distributed as a unit normal under H0. So, we can reject H0 in favor of Ha if √𝐸𝐸�ln�𝜆𝜆̂� − ln(𝜆𝜆)� <
−𝑧𝑧1−𝛼𝛼 .
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Power Calculation
Jung (2013) gives the following power and sample size formulas for a one-sided hypothesis test based on 𝜆𝜆̂. Note
that we use the subscript 0 to represent the historic control and the subscript 1 to represent the new treatment
group.
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = Φ�√𝐸𝐸�ln�𝜆𝜆̂� − ln(𝜆𝜆)� < −𝑧𝑧1−𝛼𝛼 |𝐻𝐻𝑎𝑎 �

Assuming a uniform accrual, the censoring distribution function G(t) is given by
𝐺𝐺(𝑡𝑡) =

1
⎧
⎪𝑡𝑡𝑎𝑎 + 𝑡𝑡 − 𝑡𝑡
𝑓𝑓
⎨
⎪
⎩

𝑡𝑡𝑎𝑎
0

if 𝑡𝑡 ≤ 𝑡𝑡𝑓𝑓

if 𝑡𝑡𝑓𝑓 ≤ 𝑡𝑡 ≤ 𝑡𝑡𝑎𝑎 + 𝑡𝑡𝑓𝑓
otherwise

where ta represents the accrual time and tf represents the follow-up time.
The required number of events is
𝐸𝐸 =

2

�𝑧𝑧1−𝛼𝛼 + 𝑧𝑧1−𝛽𝛽 �
λ 2
�ln � 0 ��
𝜆𝜆1

Under the uniform accrual assumption, the sample size is
𝑁𝑁 =
where
𝑃𝑃1 = 1 − (1 − exp(−𝜆𝜆1 𝑡𝑡𝑎𝑎 ) �

exp(−𝜆𝜆1 𝑡𝑡𝑓𝑓 )
�
𝜆𝜆1 𝑡𝑡𝑎𝑎

2

�𝑧𝑧1−𝛼𝛼 + 𝑧𝑧1−𝛽𝛽 �
λ 2
𝑃𝑃1 �ln � 0 ��
𝜆𝜆1

𝑃𝑃1 is the probability that a subject experiences an event during the study.

This sample size formula can be rearranged to give an expression for power.

Accrual Rate Known
If only the accrual rate Ra is known instead of the accrual time ta, the accrual time is unknown at the time of
sample size calculation. The required value of Ra is found by solving
𝑡𝑡𝑎𝑎 𝑅𝑅𝑎𝑎 𝑃𝑃1 =
for ta. Note that 𝑃𝑃1 is also a function of ta.

2

�𝑧𝑧1−𝛼𝛼 + 𝑧𝑧1−𝛽𝛽 �
λ 2
�ln �𝜆𝜆0 ��
1
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Alternative Hazard Rate Input Types
There are multiple quantities that can be used. Assuming that failure times follow a two-parameter Weibull
distribution, the cumulative survival function S(t) under null and alternative is given by
𝑆𝑆0 (𝑡𝑡) = 𝑒𝑒𝑥𝑥𝑝𝑝�−𝜆𝜆0 𝑡𝑡𝑘𝑘 �
𝑆𝑆1 (𝑡𝑡) = 𝑒𝑒𝑒𝑒𝑒𝑒�−𝜆𝜆1 𝑡𝑡𝑘𝑘 �

The hazard and cumulative hazard functions are given as
𝜆𝜆0 (𝑡𝑡) = 𝑘𝑘𝜆𝜆0 𝑡𝑡 𝑘𝑘−1

𝜆𝜆1 (𝑡𝑡) = 𝑘𝑘𝜆𝜆1 𝑡𝑡 𝑘𝑘−1

Λ 0 (𝑡𝑡) = 𝜆𝜆0 𝑡𝑡 𝑘𝑘

The hazard rates λ0 and λ1 can be given in terms of the hazard ratio HR, the median survival times M0 and M1, or
the cumulative survival proportions S0 and S1 at time t0. These various parameters are defined as
𝐻𝐻𝐻𝐻 = 𝜆𝜆1 /𝜆𝜆0
𝜆𝜆0 =
𝜆𝜆1 =

log 2 − log 𝑆𝑆0 (𝑡𝑡0 )
=
𝑡𝑡0
𝑀𝑀0

log 2 − log 𝑆𝑆1 (𝑡𝑡0 )
=
𝑡𝑡0
𝑀𝑀1

𝑆𝑆0 (𝑡𝑡) = 𝑒𝑒𝑒𝑒𝑒𝑒(−𝜆𝜆0 𝑡𝑡)
𝑆𝑆1 (𝑡𝑡) = 𝑒𝑒𝑒𝑒𝑒𝑒(−𝜆𝜆1𝑡𝑡)

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with. This chapter covers
four procedures, each of which has different effect size options. However, many of the options are common to all
four procedures. These common options will be displayed first, followed by the various effect size options.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power, Sample Size, and Effect Size. Note that the Effect Size depends on the parameterization that is
chosen.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power.
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Test
Alternative Hypothesis
Specify whether the statistical test is two-sided or one-sided.
•

Two-Sided
This option tests whether the two hazards rates, median survival times, or survival proportions are different
(Ha: λ1 ≠ λ0). This option causes α/2 to be substituted for α in the calculations.

•

One-Sided
When this option is used and the value of λ1 is less than λ0, rejecting the null hypothesis results in the
conclusion that the new group’s hazard rate (λ1) is less than the historic control hazard rate (λ0). Otherwise,
the opposite conclusion is reached.
When you use a one-sided test, you should divide your alpha level by two to keep your significance level
comparable to that of a two-sided test.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal hazard rates when in fact the hazard rates are different.
Values must be between zero and one. Historically, the value of 0.80 was used for power. For phase II trials, 0.90
is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.90 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you
reject the null hypothesis of equal hazard rates when in fact the hazard rates are equal.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for a two-sided test
and 0.025 has been used for a one-sided test. You should pick a value for alpha that represents the risk of a type-I
error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
Enter a value for the sample size, N. This is the number of subjects in the study. You can enter one or more
positive integers greater than or equal to 3. You may also enter a range such as “10 to 100 by 10” or a list of
values separated by commas or blanks such as “20 40 60 80.”
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Accrual Input Type
Specify what you will enter to indicate how subjects will be added to the study.
Your choices are
•

Ta (Accrual Time)
Specify Ta, the accrual time. Assume that subjects will be added to the study at a constant rate during this
period.

•

Ra (Accrual Rate)
Specify Ra, the accrual rate. Assume that subjects will be added to the study at this rate during the yet to be
determined accrual period.

Ta (Accrual Time)
Enter one or more values for the number of time periods (months, years, etc.) during which subjects are entered
into the study. The total duration of the study is equal to the Accrual Time plus the Follow-Up Time.
Ra (Accrual Rate)
Enter one or more values for the rate at which subjects are added to the study group. Specify this rate using the
same time units as the follow-up time and the hazard rates. Common choices are years, months, or days.
Note that using months as the time period may cause confusion because of the variable number of days per
month.
The range is Ra > 0.
Tf (Follow-Up Time)
The length of time between the entry of the last individual and the end of the study. Tf > 0.

Effect Size
Hazard Rates Input Type
Specify which set of parameters you want to use to specify the hazard rates of the historical control (λ0) and the
new group from which the sample is drawn (λ1). These parameters are functionally related, so the values of λ0
and λ1 are calculated from the items you enter (if necessary).
The possible choices are
•

λ0, λ1 (Hazard Rates)
Enter the values of the two hazards rates (λ0 and λ1) directly.

•

λ0, HR (Hazard Rate, Hazard Ratio)
Enter the hazard rate of the historical control (λ0) and the hazard ratio (λ1 / λ0).

•

M0, M1 (Median Survival Times)
Enter the median survival times of the historical control (M0) and the new group (M1). The values of λ0 and
λ1 are calculated based on the exponential distribution using
λᵢ = -log(2) / Mᵢ.

•

M0, HR (Median Survival, Hazard Ratio)
Enter the median survival times of the historical control (M0) and the hazard ratio (λ1 / λ0).
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•

S0, S1 (Proportions Surviving)
Enter the proportions surviving for a fixed period of time (T0) of the historical control (S0) and the new group
(S1). The values of λ0 and λ1 are calculated based on the exponential distribution using
λᵢ = -log(Sᵢ(T0)) / (T0).

•

S0, HR (Proportion Surviving, Hazard Ratio)
Enter the proportions surviving for a fixed period of time (T0) of the historical control (S0) and the hazard
ratio (λ1 / λ0).

λ0 (Hazard Rate – Control)
Enter a value (or range of values) for the exponential hazard rate (event rate or incidence rate) of the historical
control.
This rate is compared to λ1 by the test based on the average hazard rate described above. The ratio of these rates,
HR = λ1 / λ0, is the amount that this design can detect.
The value must be greater than zero.
Example of Estimating λ0
If 200 control patients were followed for 1 year and 40 experienced the event of interest, the hazard rate would be
λ0 = 40/(200*1) = 0.2 per patient-year.
Similarly, if 200 patients were followed for 2 years and 40 experienced the event of interest, the hazard rate would
be
λ0 = 40/(200*2) = 0.1 per patient-year.
Note that this estimate does not consider the censoring. For censored survival data, it is often estimated from a
survival distribution fitted from historical data. For example,
𝜆𝜆0 = −

ln 𝑆𝑆(𝑡𝑡0 )
𝑡𝑡0

λ1 (Hazard Rate – New)
Enter a value (or range of values) for the hazard rate (event rate or incidence rate) of the distribution of the
response values in the new group. This distribution is assumed to be exponential.
This rate is compared to λ1 by the test based on the average hazard rate described above. The ratio of these rates,
HR = λ1 / λ0, is the amount that this design can detect.
The value must be greater than zero.
Example of Estimating λ1
Once we have λ0 and HR, λ1 is obtained as follows
𝜆𝜆1 = 𝐻𝐻𝐻𝐻(𝜆𝜆0 )

HR (Hazard Ratio)
Enter one or more values for HR, the hazard ratio λ1 / λ0. This value is used with λ0 to calculate a value for λ1.
HR can be any number greater than zero and unequal to one. You may enter a single value or a range of values.
M0 (Median Survival - Control)
Specify a single value, or set of values, for the median survival time in the historical control group. Assuming a
Weibull distribution with shape parameter k, the value of λ0 is calculated as given in the technical details above.
This value must be a number greater than zero.
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M1 (Median Survival - New)
Specify a single value, or set of values, for the median survival time in the new (treatment) group. Assuming an
exponential distribution, the value of λ1 is calculated as given in the technical details above.
This value must be a number greater than zero.
S0 (Proportion Surviving - Control)
Enter the proportion surviving (S0) for a fixed period of time (T0) in the historical control group. The value of λ0 is
calculated as given in the technical details above.
Since this is a proportion, it must be a value between (but not including) zero and one. You may enter a single
value or a range of values.
S1 (Median Survival - New)
Specify a single value, or set of values, for the median survival time in the new (treatment) group. Assuming an
exponential distribution, the value of λ1 is calculated as given in the technical details above.
This value must be a number greater than zero.
T0 (Time of S0 and S1)
When S0 and S1 are selected as the Input Type, this value is needed to give the amount of time that S0 and S1 are
related to. Since this value is a time period, it must be a positive value.
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Example 1 – Finding the Sample Size
A researcher is planning a clinical trial to compare the response of a new treatment to that of the current
treatment. The median survival time in the current population is 1.54. The current population of responses
exhibits an exponential distribution. The researcher wants to know the sample sizes needed to detect hazard ratios
of 0.7 and 0.8 at 90% power and a 5% significance level for a two-sided, test of the estimated hazard rate. The
accrual period will be 1 year. The researcher would like to compare the sample requirements if the follow-up
period is 1, 2, or 3 years.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.

Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Accrual Input Type .................................. Ta (Accrual Time)
Ta (Accrual Time) ................................... 1
Tf (Follow-Up Time) ................................ 1 2 3
Hazard Rates Input Type ........................ M0, HR (Median Survival, Hazard Ratio)
M0 (Median Survival - Control) ............... 1.54
HR (Hazard Ratio - λ1/λ0) ...................... 0.7 0.8

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Hypothesis Type: Two-Sided
Test Statistic: One-sample exponetial hazard rate based on the MLE
Data Distribution: Exponential

Power
0.9002
0.9003
0.9018
0.9001
0.9002
0.9008

N
221
510
153
357
124
296

Events
E
82.6
211.0
82.6
211.0
82.6
211.0

Accr
Time
Ta
1.0
1.0
1.0
1.0
1.0
1.0

Accr
Rate
Ra
221.0
510.0
153.0
357.0
124.0
296.0

Follow
Up
Time
Tf
1.0
1.0
2.0
2.0
3.0
3.0

λ1/λ0
Haz
Ratio
HR
0.700
0.800
0.700
0.800
0.700
0.800

Cntl
Haz
Rate
λ0
0.450
0.450
0.450
0.450
0.450
0.450

New
Haz
Rate
λ1
0.315
0.360
0.315
0.360
0.315
0.360

Cntl
Med
Surv
M0
1.54
1.54
1.54
1.54
1.54
1.54

New
Med
Surv
M1
2.20
1.93
2.20
1.93
2.20
1.93

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

Prob
Event
P1
0.374
0.414
0.543
0.591
0.667
0.715

References
Jung, Sin-Ho. 2013. Randomized Phase II Cancer Clinical Trials. Chapman & Hall / CRC. Boca Raton, Florida.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the sample size of the New group, assuming no subject lost to dropout or follow-up during the study.
E is the expected number of events (failures) in the new group during the study.
Ta is the length of the accrual time during which subjects are added to the study.
Ra is accrual rate at which subjects are added to the study. Subjects are added uniformly during the accrual
period.
Tf is the length of the follow-up time after the last subject is added to the study.
HR is the hazard ratio (λ1/λ0) is the new group's hazard rate divided by the hazard rate of the historic control.
λ0 is the hazard rate of the historic control (standard).
λ1 is the hazard rate of the new group.
M0 is the median survival time of the historic control group.
M1 is the median survival time of the new (treatment) group.
Alpha is the probability of rejecting a true null hypothesis.
P1 is the probability that a subject in the new group experiences an event (failure) during the study.
Summary Statements ─────────────────────────────────────────────────────────
A two-sided, one-sample test using the MLE of exponential data calculated from a sample of 221 subjects
achieves 90.0% power at a 0.050 significance level to detect a hazard ratio of 0.700 when the median survival
time of the historic control group is 1.54. Subjects are accrued for a time period of 1.0. Follow-up continues for a
period of 1.0 after the last subject is added. The probability that a subject experiences an event during the study
is 0.374. The expected number of events during the study is 82.6. It is assumed that the survival time distribution
is approximated reasonable well by the exponential distribution.

This report presents the calculated sample sizes for each scenario as well as the values of the other parameters.

Plots Section

This plot shows the relationship between sample size, follow-up time, and HR.
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Example 2 – Validation using Jung (2013)
Jung (2013) page 59 gives an example in which the power = 0.80, alpha = 0.1 for a one-sided test, Ra = 60 and Tf
= 1, 𝜆𝜆0 = 0.693, and 𝜆𝜆1 = 0.462. Jung calculates N to be 77.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the. You may then make the appropriate entries as listed below, or open Example 2 by going to the
File menu and choosing Open Example Template.

Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ One-Sided
Power ...................................................... 0.90
Alpha ....................................................... 0.1
Accrual Input Type .................................. Ra (Accrual Rate)
Ra (Accrual Rate) ................................... 60
Tf (Follow-Up Time) ................................ 1
Hazard Rates Input Type ........................ λ0, λ1 (Hazard Rates)
λ0 (Hazard Rate - Control) ..................... 0.693
λ1 (Hazard Rate - New) .......................... 0.462

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypothesis Type: One-Sided
Test Statistic:
One-sample exponetial hazard rate based on the MLE
Data Distribution: Exponential

Power
0.9020

N
77

Events
E
40.0

Accr
Time
Ta
1.3

Accr
Rate
Ra
60.0

Follow
Up
Time
Tf
1.0

λ1/λ0
Haz
Ratio
HR
0.667

Cntl
Haz
Rate
λ0
0.693

New
Haz
Rate
λ1
0.462

Alpha
0.100

Prob
Event
P1
0.524

PASS has also calculated N as 77. Thus, the procedure is validated.
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